AE02 Activedition Training

4.0.0 Administrator

C(2) Software

Further Information:
C(2) Software
Software Centre
Technology Park
Dundee
DD2 1TY
T: +44 (0)1382 598450
E: training@c2software.com

© 2006 C2 Software Limited - This document is provided for the assessment of services and is for internal use only. It may not be distributed externally without the prior permission of C2 Software Limited.
Introduction

Course Description

The Administrators Course is aimed at IT and Internet professionals who require an understanding of the broad working capability of Activedition, or who are already Content Contributors and are about to take on responsibility for Activedition Content Administration. This course highlights best practice administration practices.

Prerequisites

This course assumes that users are familiar with Activedition and are able to manage content using tools like the Content Manager and Activedition libraries.

Objectives

On completion of this course the candidate will:

- Be familiar with and able to use the additional content tools: Form Manager, FAQ Manager, Newsgroup Manager and the Tag Manager.
- Be able to use the Menu Manager to manage both standard and customised site navigation.
- Be able to manage users and user groups, mailing lists and stored messages.
- Be able to understand what Meta Data is and the different ways in which it can be used.
- Be able to publish updated content to the live site.
- Be able to use and manage Site Statistics.
- Be able to understand the Site Setup and use the Configuring System Options.

Manual Structure

This manual is designed to be used as either a reference tool or training guide. The manual is broken down into sections, each section being broken down into lessons.

- Each lesson begins with aims and learning objectives.
- At the end of each lesson the covered objectives are reviewed followed by an exercise.
- At Appendix A to this Manual is a Glossary of terms.

User Feedback

Your feedback is important to us and will help to ensure that this manual remains a quality product. If you have any feedback please contact us at:

C(2) Software
Tayside Software centre
Technology Park
Dundee
DD2 1TY
training@c2software.com
Section One - Site Management

Aims and Learning Objectives

This section will familiarise you with the additional Content Management tools available to Administrators such as Version History and FAQ’s. After this section you will have learned the following:

- How to use Version History using either the *Use this Version* button or the *Rollback* button to replace a section of content with a chosen version.

- How to use the FAQ Manager to create and organise the Frequently Asked Questions pages into user defined categories using either the *Site Tools/FAQ* or the *System Files/FAQ2* pages.
Lesson One - Version History

Version History allows administrators to use or rollback to previous versions of a particular section of content. Each time a Section is edited and saved another version is created. The number of versions that are stored in the database can be set in the System Options (Lesson Fourteen).

Note: There is no way of recording tag placements in version history.

Using Version History

To view the Version History choose the View->History option on the Section Menu in the Page Explorer. In the new window that opens, stored versions of the Section will be listed in the left hand pane detailing the version number, date and time saved and user, clicking a version will show the stored content in the right hand pane.

Note: The current version is not shown.

- Choosing the HTML option will preview the Page Section Version
- Choosing the Source option will show the HTML source code and Activedition placement location tags.
- Clicking the Use this Version button will replace the current section content with chosen version.
- Clicking the Rollback button will replace the current section content with chosen version and will also delete all subsequent stored versions of the section.
Exercise: Version History

1. Edit the myname_home page, adding some text to a section
2. Use version history to rollback to the previous version
3. Edit the section again deleting all the placed links
4. Use the ‘Use This Version’ option to use previous version.

Notes
Lesson Two - FAQs

The FAQ manager enables the rapid creation of Frequently Asked Questions pages. The FAQs are organised into user defined categories and can be linked to using the *Site Tools / FAQ* and *System Files / FAQ2* pages.

The FAQ page is a custom page that will display a list of all Categories in a drop list, selecting a category will display the appropriate FAQ. The FAQ2 page is a custom page that will only display a single FAQ Category. To use the FAQ2 page you need to create a link to it in the *Link Library* that uses a query string to display a single specified category only.

FAQ questions and answers are text based and do not have any of the editing features available with Sections, although they will accept standard HTML tags; these are generally only used if links need to be added.

Creating a new Category

- Click on the **FAQ Manager** link at the top of the tree view and choose the *Add -> Category* option.
- Enter the category name in the *Value* textbox, category names *can* contain spaces.

Once saved the category name will appear in the Category droplist in the left hand pane, and the list will refresh to show the new category questions (currently empty) allowing you to add FAQs.
Adding Questions and Answers

To add a question click on the FAQ Manager link at the top of the tree view and choose Add-> Question. The Add New FAQ Question form has two Tabs:

- General
- Advanced

### General

- **Name Tag**
  This is the question name as it will appear in the list on the left, it will not be visible on the FAQ page.

- **Question Text**
  This is the question text
Add New FAQ Question

General

**Settings**
- **Category**: Training
- **Order**: 10

Save  Cancel

Advanced

- **Select Category**
  This option can be used to save the question to another category.

- **Order**
  The order of the question relative to other questions in the category can be determined here.

To add an answer click on the question and choose the **Add Answer option**. The **Add New FAQ Answer** form has two Tabs:

- **General**
- **Advanced**

Add New FAQ Answer

General  Advanced

**Name**

**Type**
- Text  Library Section

**Answer Text**

Save  Save and Add another  Cancel
General

- **Name**
  This is the answer name as it will appear in the list on the left; it will not be visible on the FAQ page.

- **Type**
  There are two types of answers:
  - **Text**
    Select this option to enter answer directly into the Answer Text box.
  - **Library Section**
    Select this option to import a Section from the Section Library.

Advanced

- **Select Question**
  This option can be used to move the answer to a different question.

- **Order**
  Each answer represents a paragraph of text. If there are multiple answers you can determine their order relative to each other using this field.

When the answers are completed click onto the **Save** or **Save and Add another** button

In order to view the FAQ it needs to be published:

- In the **FAQ Manager** select the category required for publishing.
- Click onto the **FAQ Manager** link at the top of the tree view and choose **Publishing** - > **Publish FAQ**.
- Click onto the **Perform Publish Pre-check** button in the right hand pane.
- Once Publishing is completed either click onto the **View** link to view page or click onto the **Continue** button.
Linking to a Single FAQ category

- Open the Link Library and Add a Link.
- Choose the Internal Web Page Link type.

In the General Tab:

- Add a Link Name.
- Add a Description.
- Click onto the Choose link and search for `faq2`, click onto the System Files `faq2` page link.

![Add New Link to Internal Web Page](image)

In the Accessibility Tab:

- An Access key can be added if required.
In the **Advanced** Tab:

- Select the required Target.
- Tick the *Append* checkbox.
- In the *Value* textbox type `category=[faq category]`. The category name must be exactly as displayed in the FAQ manager.

**Note:** This link will display the chosen category of FAQ only; the category selection drop list will not be available.

**Exercise: FAQs**

- Create a new FAQ category `myname_faq`.
- Add 3 questions and answers to the category.
  - Include multiple answers for a single question.
  - Include a link in one of the answers.
- Create a link to the FAQ category in the Link library using the `category=` querystring.
- Place the link on a page and view the FAQ.

**Notes**
Section One - Review

Lesson Summary

In this Section you learnt:

1. The functionality of Version History and the difference between *Use this Version* and *Rollback*.

2. How to use the FAQ Manager and the following functions:
   a. Creating a new Category.
   b. Adding Questions and Answers.
   c. Linking to a single FAQ category using the FAQ2 custom page.

Notes
Section Two - Libraries

Aims and Learning Objectives

This section will look at the additional Libraries and functions that are not available to Content Contributors. Here you will learn how to add a Library and publish Library Items, Create Newsgroups, use the Tag Library and create Forms and Polls using the Form Manager. After this section you will have learnt the following:

- How to use the additional functionality available to Administrators in the various Libraries.
- How to create new libraries and publish library items.
- How to create Newsgroups using the Newsgroup Manager.
Lesson Three - Administering Libraries & Newsgroups

Administrators have access to all user created libraries, unlike Content contributors who need to be authorised to update user created library content. Administrators also have the ability to create new user defined libraries and publish library items and also add new Newsgroups when required. Administrators can also have access to the Tag Manager where new tags can be created and managed.

Common Library Functions

Adding a New Library

User created Libraries can be added to the Section, Files, Multimedia Library and the Forms and Menu Manager. Clicking on the library or manager name at the top of the tree view and choosing the Add->Library option will display the following Add New Library form:

- The Name is used for reference within Activedition, when adding or placing library items.
- The Description is only visible by viewing the library properties.

There is an additional Availability Tab when adding a Library in the File Manager. This displays a checkbox which allows the library to be included in a search, providing the Allow File Searching checkbox in System Options -> Delivery Application is ticked. Once a Library has been added appropriate authorisations will have to be set for Content Contributors access.
Publishing Library Items

When an item is updated in any of the Libraries it requires publishing before becoming available in the live website. As an administrator this can be done directly from the library rather than by publishing a page containing the item.

Items can be published by choosing the Publishing -> Publish [type] option available on the item menu, this will display the Publish Individual Content page, after the Publish button has been clicked the item will be published and success confirmed.

Version History

Lesson one describes how Version History can be applied to a section and used to either Rollback or Use a selected version. The same functionality can be applied to an uploaded file in the File Library or a Section in the Section Library. If a replacement for a file is uploaded the previous version of the file will be saved, the same happens when a Section is amended and saved. Clicking onto Use This Version will update the File or Section with the selected version, Clicking onto Rollback will rollback to a selected version deleting all subsequent versions. In the File Manager selecting Download will allow you to Open the file for viewing.
The Tag Library

The tag library enables custom elements of HTML, ASP, JavaScript or other code to be placed on Sections, a Tag will always appear above the section that it is placed on.

Adding a Tag Library

Click onto the Library name at the top of the tree view using the right mouse button and choose the *Add -> Library* option, the form and its functionality is described on page 20.

View Tag Properties

To view the properties of an existing Tag click onto the tag name, the Tag Properties will be displayed in the right hand pane.

Adding a Tag

Click the *Tag Manager* link at the top of the tree view and choose the *Add Tag* option.
The form is divided into two Tabs, General and Advanced.

**General**
- The *Name* is used for reference in the Tag list on the left and when placing tags.
- The *Description* is visible when editing the tag.
- The *Code* is the source code itself.

**Advanced**
- The *Library* is used to store the Tag in an available library.

**Other functions**

Right mouse clicking onto an existing tag will give you the following options:

- **Tasks -&gt; Delete Tag**
  Selecting this option will display the Delete Tag form in the right hand pane where you are given an option to delete tag or cancel deletion.

- **Publishing -&gt; Publish Tag**
  This option will displayed the Publish Individual Content page in the right hand pane, after the Publish button has been clicked the tag will be published and success confirmed.

- **View -&gt; Placements**
  This option will display a list of all pages that the Tag is placed on

- **Properties**
  Selecting this option will display the Tag Properties form in the right hand pane.
The Newsgroup Manager

As well as the ability to moderate and update newsgroups, Administrators also have the ability to create newsgroups using the Add->Newsgroup menu option on the Newsgroup Manager menu.

Creating Newsgroups

• Click onto the right mouse button onto the Library name at the top of the tree, and select the Add Newsgroup option

The Add New Newsgroup form will be displayed in the right hand pane, this form has two Tabs:

General

• Name
  This is for reference within the Newsgroup Manager and when placing links to the newsgroup.

• Description
  This is used as the default text for links to the newsgroup when the newsgroup is first created. To update the default text for a link to an existing newsgroup you need to update the link library.

Advanced

• Allow Public Access
  If enabled users do not need to be authorised / login with an Activedition user ID to contribute to a newsgroup.

• Allow Anonymous Postings
  If allowed the user has the option of their username not being displayed with the posting.

• Allow Attachments
  Will display a dialogue box in the Newsgroup to facilitate attachments.

• Email New Posts To
  Postings will be sent to this email address regardless of whether the newsgroup is moderated or not. This allows the content of unmoderated newsgroups to be monitored.
• **Moderated**
  If a newsgroup is moderated postings will not be visible until they have been approved.

• **Moderator Email**
  This is the email address of the Content Contributor or Administrator that responsible for moderating the newsgroup. Every time there is a posting this user will be emailed the posting and advised that they need to approve the postings for them to go live.
**Exercise: Libraries & Newsgroups**

1. Create a new Section Library *myname_sections*
   a. Add a new section to the Library, publish the section

2. Create a new file Library *myname_files*
   a. Do not make searchable
   b. Upload a file to the new Library

3. Create a new Multimedia Library *myname_images*
   a. Move an existing image to the new Library, publish the image

4. Upload a file into the File Library, and then upload two replacement files. Open version 1 to view the file.

5. Revert back to version 2 then rollback to version 1.

6. Check that version 1 is the original uploaded file.

7. Create the following tag giving it the name [your name_tag] e.g. bobs_tag, then place it on a page.
   <html>
   <body>
   <%
   dim trgname

   trgname="<AEPARAMETER name="Enter your name" description="text for trgname tag"
   mandatory="n" />

   response.write("Your name is:"&trgname)
   %>
   <hr>
   </body>
   <html>

8. Create a Newsgroup *myname_news*
   a. Unmoderated
   b. Email all postings to your email address

9. Post a link to the newsgroup on the *myname_home* page
   a. Visit the newsgroup and add a posting
Section Two - Review

Lesson Summary

In this Section you learnt:

1. How to use the following additional Library functions available to Administrators:
   a. Adding a New Library
   b. Publishing Library Items
   c. Creating Newsgroups
   d. Using and Editing Tags

Notes
Section Three – Content Based Administration

Aims and learning Objectives

This section details content related administration features and their use. Here you will learn how to use the Administration tools that manage Templates and Content Types. After this section you will have learned the following:

- How templates are written, and how to upload new or replacement templates into the system.
- What content types are and how they can be used
- How to create new content type categories and attributes
Lesson Four – Templates

Creating Templates
This lesson serves as an introduction to Templates and is covered in more depth in the Designer Course. The Template Manager controls the upload and management of templates for use within the system. A template is created for Activedition by first building the basic design for the HTML template as normal, using a folder called `templatename_files` to store all the images/ multimedia used in the template.

Once this is complete it can be marked-up for use with Activedition. Activedition uses a number of custom tags to define links, page title, heading, stylesheet, meta, menu and content areas, allowing them to be controlled/edited through the management application.

Examples of some commonly used tags are as follows:
- `<aepage_customcode>...</aepage_customcode>`
  This tag defines the area of the template where the code from a custom page will be placed. All HTML between these tags will not be visible on a custom page.

- `<aepage_title />`
  This will display the title as saved in the page details form in the management application. This tag is usually placed between the `<TITLE> </TITLE>` HTML tags so that the current page title is displayed in the top bar of the browser.

- `<aepage_heading />`
  This will write out the heading as saved in the page details form in the management application.

- `<aessection />`
  This will write out the next Page Section for the current page. A 'section' is the area of content that you can edit by clicking onto a section in the Page Editor.

Uploading Templates
When created, the template can be uploaded into Activedition using the Upload Template menu option in the Template Manager. This will upload the HTML template and all the required files in the associated resource folder so that the template can be used in Activedition. Amendments to templates can be applied by using the Upload Replacement option, similar to that found in the file library.

Other Features
- **Edit template**
  This will open the template source code in a simple text editor allowing changes to be made.

- **Downloading Template**
  This allows you to download the Source Code Only for the chosen template. The associated files will not be downloaded.

- **Publish Supporting Files**
  This will download the files in the Resource Folder Only. To republish the template a page using that template has to be published.

- **Validate Template**
  This option will initiate a validation service which will check the template for Accessibility issues and report back if any have been found or not.
Lesson Five - Content Types and Meta Data

The Content Type manager provides the framework for classification, categorisation, configurable content management and content personalisation. Using this manager the Activedition platform can be tailored to a particular project’s or organisation’s requirements. Meta Data Types allows additional forms to be created for completion by Content Contributors and administrators while using Activedition, these forms can be associated with Areas, Pages, Sections, Users, Files or Forms. When completed the information in the particular form will be associated with the particular item. There are three main ways that Meta Types can be used within Activedition, Content Classification, Content Presentation and Meta Data Applications.

Content Classification

This allows the classification of different types of content to aid in the site management process, for example particular uploaded files, sections, pages and areas could be associated with a company department.

Meta Data Search

The Meta Data search can be used to find all items within Activedition that are associated with that department. Appropriate management options will be offered dependant on the item returned: the properties of a file can be edited, a page can be explored, user details can be edited etc.
Content Presentation

Meta Data can also be displayed on the site by using `<aemeta />` tags in a template. This allows fields completed in the area or page metadata to be displayed on a page using the appropriate template.

An example of how **Area Meta Data** can be used for display could be that a corporate website wants templates containing different images and contact addresses for each of its 25 departments, while at the same time retaining the same overall corporate branding.

A simple use of metadata to set appropriate image and address attributes on site areas can allow this to be achieved using a single template, and allows business users to update these template items through metadata rather than involving designers to recode the templates.

First Attributes for the department Image and Address would be created on the Area Meta Data; if all areas of the site are to use this information completion of the Meta Data form can be enforced. Then, after saving Site Area properties (during creation / editing) a Content Contributor or Administrator would be shown a form similar to the following:

![Meta Properties: Edit](image)

**Notes**
These fields are then used in the site template, giving each department an individual look. All pages created in the area that use the appropriate template will display this information:

![Template Example](image1)

Pages in a Site Area for a different department will have different Meta Data, this will reflect in the template:

![Template Example](image2)

While Area Meta Data can be used to control content on an area wide basis, Page Meta data can be used to display content for a particular page only. This is mostly used when there is a requirement to strictly control the presentation of all or part of a certain type of page in the website.

An Example of how Page Meta Data could be used to enforce such control would be for a staff directory used on our company site in the previous example. Since not all pages will necessarily be staff pages we can create a Sub Meta Type containing attributes relevant to staff pages only, the form containing these attributes will only need to be completed if the page is marked as having a Staff Meta Type.
This information can then be displayed on the staff page with the layout described in the staff directory template (which can also use the area Meta data if desired):

**In the Meta Data Tab of Page Properties:**

<table>
<thead>
<tr>
<th>General</th>
<th>Availability</th>
<th>Publishing</th>
<th>Advanced</th>
<th>Meta Data</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Options</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>Staff</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edit on Save</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Staff Directory

## Staff Member

### Name
- Jim McCready

### Position
- Junior Accountant

### Skills
- Sage 100, Doing Big Sums, Making Coffee

### Phone
- 01452 335 223

### Email
- jmccready@company.com

### Description
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah blah blah
- blah blah b...
When creating the template it is possible to specify that the Meta Data is editable through Browse and Edit, in this case a green activedit logo will appear next to the Meta Data Item in browse and edit, clicking it will allow you to edit that field.

**Graphics require amending**

**Notes**
Applications

Meta data has many uses within applications, the attributes used to classify content can be used to create searchable catalogues and directories, a registration script may use meta data on users to store more than the simple details in the user manager, it could be used on pages and sections to drive news and events applications.

A very simple example application could be a staff search based on the directory in the previous example, an ASP custom page could be written that searches all staff pages on the different meta data fields e.g.:

<table>
<thead>
<tr>
<th>Department</th>
<th>Position</th>
<th>Skills</th>
<th>Account</th>
<th>Making Coffee</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounts</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Results: (click name to view staff directory page)

<table>
<thead>
<tr>
<th>Name</th>
<th>Job Title</th>
<th>Email</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jim McCreadie</td>
<td>Junior Accountant</td>
<td><a href="mailto:jmccreadie@company.com">jmccreadie@company.com</a></td>
</tr>
<tr>
<td>Betty Woolley</td>
<td>Senior Tea Lady</td>
<td><a href="mailto:bwoolley@company.com">bwoolley@company.com</a></td>
</tr>
</tbody>
</table>

Adding Sub Meta Types and amending Properties

Existing Meta Types can be edited, and new ones (Sub Meta Types) added through the Meta Type Manager.

Process:

- Click onto required Meta Type.
- Hover mouse over Add and select Sub Meta Type.

In the General Tab enter a name for the Sub Meta Type in the Name field. This is the name of the Meta Type as seen in the Meta Type Manager. This field is only editable on user created Meta Types.

- Enter a short description of the Meta Type and its purpose in the Description field; this is only visible from the Meta Type Properties form.
• In the Advanced Tab the Published Meta Data Database Field name will have been updated by the Name field in the General Tab. Note that there should not be any spaces in the name.

• There are three Edit on Save options

  ▪ Display Meta Form Default
    This will tick the “edit meta data” box at the foot of the object properties page (e.g. Area Properties Meta Data) by default. This encourages metadata to be edited when the object properties are edited. Note that this will only take effect for sub Meta Types if the appropriate Sub Meta Type has been selected.

  ▪ Display Meta Form On Add
    This will force the Content Contributor or Administrator to Edit the Meta Data For the Object that the Meta Data relates to when it is first added to the system - e.g. when a Page or Staff page is added.

  ▪ Display Meta Form On Edit
    This will force the Content Contributor or Administrator to Edit the Meta Data For the Object that the Meta Data relates to when it is edited - e.g. when a Pages properties are edited.
Adding Meta Type Attribute and amending Properties

Attributes can be added to Meta Types in the same way that questions can be added to forms in the Form Manager. These attributes will be displayed on the Meta Properties form, e.g. the Page Meta Properties optionally displayed after editing a pages property.

Additional to the field types available in Form creation Meta Type Attributes can be of the following:

- **Multimedia**
  An item from the multimedia library type.

- **Multiple types**
  This type allows the selection of several items from a preset list, for example in a staff pages Meta Data, rather than typing in a list of skills freehand several skills could be chosen from a preset list, the list would be first created and populated in Content Type Manager as a Multiple type.

- **GCL (Government Category List)**
  The GCL is an encoding scheme for the Subject element of the current version of the e-Government Metadata Standard (e-GMS). The purpose of the subject encoding schemes is to make it easier to find information from all the electronic resources in the UK public sector.

- **IPSV (Integrated Public Sector Vocabulary)**
  When the e-GMS is next updated the IPSV will take the place of the GCL, and the GCL will be gradually phased out.

- **Hierarchy**
  This type is used in conjunction with Vocabularies, and allows the drilling down of data within the Vocabulary.

- **Link**
  This type allows a link to be placed into the Content type, the link type can be defined during placement or left open.

**Process:**

- Right mouse click onto the required Meta Data Type in the Content Type Manager and select Explore Attributes.

- In the Meta Type Attributes Explorer right mouse click onto the Meta Type name and select Add Meta Type Attribute. The Add New Meta Type Attribute form will be displayed in the right hand pane; this has two Tabs; General and Advanced.
• **General**
  
  o **Name**  
    This is the name as appears in the list of attributes for a particular Meta Type.
  
  o **Description**  
    This is the Text that will appear in the Meta Properties Form. For example the Meta Attribute Name is ‘staffmail’, the description is ‘email,’ when completing the Meta Properties form for a staff page the Content Contributor or Administrator fills out a field (attribute) labelled email:
    
    email: [jipencer@company.com](mailto:jipencer@company.com)
  
  o **Mandatory**  
    Selecting the Mandatory field will determine whether this field must be completed or not.
  
  o **Type**  
    Select the type of attribute required from the Type dropdown field; this is the field type, e.g. small text, multimedia, dates etc.
  
  o **Default**  
    This is the option default value for the Attribute.
Advanced

- Order
  In the Advanced Tab you can change the order number of the attribute; this is the order of the attribute relative to other attributes in the Meta Properties Form.

- Published Meta Database Field
  This will be automatically entered when entering a Meta Type name in the General Tab.
  Note:  No spaces are allowed in this field.

- Linked Droplist
  If there is another completed droplist within the Metatype or Sub Meta type that the droplist is being added to, then the attributes of that list or lists can be used by selecting from the list available.

- Vocabulary
  Providing the attribute is either a Droplist, Radio Button, Multiple or Hierarchy type then Vocabularies can be used to populate them.

Using Linked Drolists

Linked Drolists can be used with either the Droplist or Multiple Meta Type Attributes. The difference between the two attributes is that the Droplist attribute is for single data input while the Multiple attribute is for multiple data inputs. An example of using either is as follows:

Linked Drolists with the Droplist attribute

To demonstrate the Droplist attribute we will use the scenario of choosing baby names so that when a gender is chosen from one droplist only names of that gender will appear in another droplist. Two drop lists are required, one containing the gender and the other containing the names. The gender droplist will contain the values Male, Female and Neutral while the names droplist will contain various names.

- In the Content Type Manager right mouse click onto the Page Type and hover mouse over Add, select Sub Meta Type.

- In the General tab of the new Meta type add the name ‘Baby Names’ in the Name fields and add the description ‘Boys or Girls names’, click onto Save.
• Right mouse click onto the ‘Baby Names’ sub meta type and select Explore Attributes.

• In the Meta Type Attributes Explorer right mouse click onto the ‘Baby Names’ Sub Meta Type and select Add Meta Type Attribute.

• In the Add New Meta Type Attribute form enter the following information in the General Tab then select Save.
  o Name: gender
  o Description: Enter Gender
  o Type: Droplist

• Right mouse click onto the gender attribute and select Add Attribute Option.

• In the Value field in the right hand pane add the following values clicking onto Save and Add another after each but the last one then click onto Save.
  o Male
  o Female
  o Neutral

• In the Attributes Explorer add another Meta Type Attribute using the following information:
  o Name: Names
  o Description: Select Baby Name
  o Type: Droplist

• Select the Advanced tab in the Linked Droplist field select the gender attribute by clicking onto the adjacent checkbox. Click onto Save.

• Right mouse click onto the Names attribute and select Add Attribute Option.

• In the Value field enter a name then select in the Linked DropList Options what gender to attribute the name with. If the name can be both Male and Female e.g. Hilary then select all three options by using multiple selection (either hold down the Ctrl key and click onto each option or select first option the hold down the Shift key and select the last option).
• Click onto *Save and Add another* for each name until the last one then click onto *Save*.

• If you expand the *Names* attribute in the *Attributes Explorer* you will see the associated drop list against the *names* attribute and the genders chosen against each name.

To see the effects of the *Baby Names* Content Type:

• Select any Area in the *Area Manager*.

• In the *Page Manager* right mouse click any Page, hover mouse over *Meta Data* and select *Properties*.

• In the Content Type dropdown list within the Meta Properties screen select *Baby Names* then locate the Gender drop down list.

• Select a gender then check the names available in the name dropdown list.

• Experiment with different genders to check that the Linked Droplists are working as they should.

### Linked Droplists with the Multiple attribute

To demonstrate the Multiple attribute we will use a scenario where one or more Football divisions can be selected. In another list only those teams that belong to the selected divisions will be displayed. Selecting one or more teams will then subsequently only display players from the selected teams in another list.

• In the *Content Type Manager* right mouse click onto the *Page Type* and hover mouse over *Add*, select *Sub Meta Type*.

• In the *General* tab of the new Meta type add the name ‘football’ in the *Name* fields and add the description ‘football’, click onto *Save*.

• Right mouse click onto the ‘football’ sub meta type and select *Explore Attributes*. 

- 39 -
• In the Meta Type Attributes Explorer right mouse click onto the ‘football’ Sub Meta Type and select Add Meta Type Attribute.

• In the Add New Meta Type Attribute form enter the following information in the General Tab then select Save.
  o Name: m_division
  o Description: Division
  o Type: Droplist

• Right mouse click onto the m_division attribute and select Add Attribute Option.

• In the Value field in the right hand pane add the following values clicking onto Save and Add another after each but the last one then click onto Save.
  o Premier
  o 1st
  o 2nd
  o 3rd
  o 4th

• In the Attributes Explorer add another Meta Type Attribute using the following information:
  o Name: m_team
  o Description: Team
  o Type: Droplist

• Select the Advanced tab in the Linked Dropdown field select the m_division attribute by clicking onto the adjacent checkbox. Click onto Save.

• Right mouse click onto the m_team attribute and select Add Attribute Option.

<table>
<thead>
<tr>
<th>General</th>
<th>Advanced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Chelsea</td>
</tr>
<tr>
<td>Linked Dropdown Options</td>
<td>Premier</td>
</tr>
<tr>
<td>1st</td>
<td>2nd</td>
</tr>
<tr>
<td>3rd</td>
<td>4th</td>
</tr>
<tr>
<td>Default Option</td>
<td></td>
</tr>
</tbody>
</table>

• In the Value field enter a football team then select from the Linked Dropdown Options what division to attribute the Team with. Complete this process by clicking onto Save and Add another until teams have been allocated into each division. When completed click onto Save.
In the Attributes Explorer add another Meta Type Attribute using the following information:
- **Name**: m_players
- **Description**: Players
- **Type**: Droplist

Select the Advanced tab in the Linked Droplist field select the m_team attribute by clicking onto the adjacent checkbox. Click onto Save.

Right mouse click onto the m_players attribute and select Add Attribute Option.

- In the **Value** field enter a players name then select from the **Linked DropList Options** what team to attribute the player with. Complete this process by clicking onto Save and Add another until players have been allocated into each team. When completed click onto Save.

- If you expand the all the attributes in the Attributes Explorer you will see the associated drop lists against the listed attributes.
To see the effects of the *football* Content Type:

- Select any Area in the *Area Manager*.
- In the *Page Manager* right mouse click any Page, hover mouse over *Meta Data* and select *Properties*.
- In the Content Type Multiple list within the *Meta Properties* screen select *football* then locate the *Division* drop down list.
- Select a division then check the Teams available in the Team Multiple list.
• Select a Team and note the players displayed in the Players Multiple list.

• Experiment with different Divisions and Teams; observe what happens when more than one Division or teams are selected by holding the Ctrl down.

<table>
<thead>
<tr>
<th>Division</th>
<th>Premier 1st</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2nd</td>
</tr>
<tr>
<td></td>
<td>3rd</td>
</tr>
<tr>
<td></td>
<td>4th</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Team</th>
<th>Chelsea</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Arsenal</td>
</tr>
<tr>
<td></td>
<td>Manchester United</td>
</tr>
<tr>
<td></td>
<td>Leeds United</td>
</tr>
<tr>
<td></td>
<td>Nottingham Forrest</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Players</th>
<th>Lampard</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Terry</td>
</tr>
<tr>
<td></td>
<td>Rooney</td>
</tr>
<tr>
<td></td>
<td>Tindall</td>
</tr>
</tbody>
</table>

**VOCABULARIES**

Below *Types* in the Content Type Manager are **Vocabularies**. Vocabularies are pre-defined lists that can either be used as answers for radio buttons or droplists in Forms and also Multiple and Hierarchy in Content Types. The benefit in using Vocabularies is the same as users have in using libraries, any changes made to the Vocabularies will be updated in the Form or Content Type that is using them. Values for Vocabularies can also be imported from CSV files.

**Adding a Vocabulary**

To add a Vocabulary complete the following process:

• In the Content Type Manager right mouse click onto **Vocabularies** and select *Add Vocabulary*.

In the displayed *Add New Vocabulary* form there are two fields to complete:

- **Name**
  Used for reference in Activedition only.

- **Hierarchy**
  This is used in conjunction with the Hierarchy question type which is found only in Content Types and will allow the user to create sub values. For example a
Hierarchy Vocabulary called *Football Teams* could be created which consists of Division values e.g. *Premier, 1st Division*. In the Division values Team sub values can be added e.g. *Chelsea, West ham*. An infinite number of sub value levels can be added, for example Player sub values can be added to the Team sub values and so on.

**Adding Values to a Vocabulary**

To add values to a Vocabulary complete the following process:

- Right mouse click onto the required Vocabulary and select *Explore Values*.

- In the Vocabulary Values Manager right mouse click onto the Vocabulary name and select *Add Value*.

![Add New Vocabulary Value form]

- In the displayed *Add New Vocabulary Value* form there are two fields to complete:
  - **Value**
    This is the option that will be seen in either the Form answers when added as a Vocabulary to either a Droplist or Radio Button question type, or a Meta Type when added as a Vocabulary to either a Droplist, Radio Button, Multiple or Hierarchy Attribute Type.
  - **Order**
    Changing this value will determine the order of the value in relation to other values within the Vocabulary.

**Importing Values to a Vocabulary**

To import Values to a Vocabulary complete the following process:

- In the Content Type Manager right mouse click onto *Vocabularies* and hover mouse over *Tasks* then select *Import Values*. 
Clicking onto the *Browse* button in the Import Values form will display the File Manager where the required values can be imported. Once the required CSV file is selected click onto *Open*.

**Note:** Only CSV files can be imported.

In the Import Values form click onto the *Import* button, the values in the CSV file will be imported into the selected Vocabulary.

### Viewing Vocabulary or Value Properties

To view the Vocabulary or Value properties either:

- Left mouse click onto the Vocabulary or Value, the properties form will be displayed in the right hand pane.
- Right mouse click onto the Vocabulary or Value then select *Properties*.

### Adding a Sub Value

Sub Values can only be added to a Value if the parent Vocabulary has the Hierarchy option switched to *Yes*.

- Right mouse click onto required Value and select *Add Sub Value*. 
In the displayed Add New Vocabulary Value form there are two fields to complete:

- **Value**
  This is the option that will be seen in either the Form answers when added as a Vocabulary to either a Droplist or Radio Button question type, or a Meta Type when added as a Vocabulary to either a Droplist, Radio Button, Multiple or Hierarchy Attribute Type.

- **Order**
  Changing this value will determine the order of the value in relation to other values within the Vocabulary.

**Using Vocabularies**

Once Vocabularies have been created they can be used as a list for dropdown lists and radio buttons in forms or dropdown lists, radio buttons or multiple question in Meta Type Attributes. If the Hierarchy option has been initiated in the properties form then the placement of this attribute will create a large text box with two buttons placed below, Add Value and Remove Value.

Clicking onto Add Value will display the Main Index form which will allow the selection of a letter, number or symbol.
Clicking onto a letter for example ‘C’ will display attributes within the Vocabulary that begins with ‘C’ in this case ‘Chelsea’.

In this case if this attribute is selected Broader Terms will display the Value ‘Premier’ and Narrower Terms of ‘Lampard’ and ‘Terry’. This is because the ‘Football’ Vocabulary had a hierarchy of Division, Team and Player respectfully; any value in Division will always be broader then Team whereas any value in Team will always be broader then Player.

Selecting ‘Premier’ will display all Premier teams while selecting any of the players will display the team they play for.

Clicking onto the Select This Term And Close button will close the form and add the selected value to the Text Box.
Clicking onto the button ‘Remove Value’ in this case will clear the text box.

**Note:** More than one value can be added to this text box.

At the base of the Main Index form is a link to Hierarchy, selecting this will display the Hierarchy form listing values that are in the top most attribute.

Main Index | Hierarchy | Close This Window

In this example selecting ‘Premier’ will display its hierarchy; selecting any value from this list will be displayed in the Term Details form thus allowing the selection of this term as previously described.

Notes
Exercise: Content Types

- Add a Sub Metatype of User *myname_User*
  - Ensure metadata is edited when a *myname_User* is added

- Add the following attributes to the *myname_User* type
  - *myname_Company* (Small Text)
  - *myname_Phone* (Small Text)
  - *myname_UserSkills* (Multiple)
  - *myname_Photo* (Multimedia)

- Edit the Metadata for a user in the User manager
  - Open the user manager
  - Click on a user in the list and choose the *meta data -> properties* option
  - Edit the properties as appropriate

- Add a Sub Metatype of Area *myname_Area*
  - Add Attribute *myname_Type* (Droplist)

- Edit the Metadata for the *myname_home* area

- Add a Sub Metatype of Page *myname_Page*
  - Add Attribute *myname_summary* (Small text)
  - Add Attribute *myname_skills* (Multiple)
    - Use the same options as for *myname_UserSkills* on *myname_User*

- Edit the Metadata for a page, ensure some of the skills are the same as those for the User edited earlier.

- Search for one of the common skills with the meta data search

Notes
Section Three - Review

Lesson Summary

In this Section you learnt:

1. The following features of the Template Manager:
   a. Uploading Templates
   b. Editing Templates
   c. Downloading Templates
   d. Publishing Supporting Files

2. There are three main ways that Meta Types can be used within Activedition:
   a. Content Classification
   b. Content Presentation
   c. Meta Data Applications

3. How to use Meta Data Search

4. The following Meta Properties
   a. Meta Type
   b. Meta Type Attribute

Notes
Section Four - User Based Administration

Aims and Learning Objectives

This section details user based administration features and their use. Here you will learn how to use the Administration tools that manage users and user groups, Notification Lists, Mailing Lists and Email Messages. After this section you will have learned the following:

- How to add new Users and Users Groups to the system, and to populate groups with members.

- How to Set Authorisations to access secure Site Areas and newsgroups, and to access Activedition to manage content

- What Notification Lists are and their use. They will be able to create new and manage existing Notification Lists

- How to create, open and authorised Mailing Lists.

- How to create Email messages and send them to Users, User Groups and Mailing Lists.
Lesson Six - User Management

Activedition supports the creation of complex user structures through the User Manager. Once created users and groups can be authorised to access and edit different areas of the website, secure newsgroups and mailing lists. Content Contributors can also have update authorisations set for Menu, Form, File and Multimedia libraries. Administrators automatically have access to all areas and features of the site.

There are two types of user group

- **Primary Group**
  This is a top level group and can contain Secondary Groups and individual users as members.

- **Secondary Group**
  This can only contain individual users as members, and can be a member of one or more Primary Groups

Authorisations and User Type set for a group are inherited by all members of that group. Higher Permissions will only have priority e.g.: 

- A Site User is the member of a Content Contributor group. In this case the site user will have the ability to edit content on the site as authorised in the group and in their personal authorisations.

- A Content Contributor is the member of a Site User group. In this case the Content Contributor will retain their delete, update and publish authorisations, they will not be limited by the Site Users restrictions, although they may have access to additional secure areas and newsgroup through the Site Users group.

Notes
Creating Users

There are three types of users that can be created, Administrators, Content Contributors and Site Users. The functionalities and roles of these users are as described in the Content Contributor Training Manual. Users can either be created manually or a custom page can be created to allow users to register via the web. In most cases users will be created manually.

Process:

• Right mouse click onto User Manager at the top of the tree view, hover mouse over Add and select User.

![User Manager](image)

- In the General Tab enter an ID for the user in the ID field. This is the Username that will be used to log in to Activedition or secure areas of the site. Maximum number of characters that can be entered here is 200 and the ID must not contain any spaces or quotes.

  **Note:** This field cannot be edited once created.

- Enter a Forename and Surname in the appropriate fields. These are visible in the User Manager only and may be used in an Activedition stored message emailed to the user.

- Enter a valid email address, all emails sent to users from Activedition to the user, including password reminders rely on this email address.
• In the Password section enter the password in both the New and Confirm fields. Try to refrain from copying the password from the New field to the Confirm field, rather type in password in both fields as this will reduce possible error of initial password being entered incorrectly. The password can be no more than 13 characters long, there is no minimum length. **Note:** Passwords are encoded in the database.

• In the Authorisation Level section enter the user type. The three user types available are Administrator, Content Contributor and Site User. Full details are described in the Concepts section of the Content Contributor Course Notes.

<table>
<thead>
<tr>
<th>General</th>
<th>Advanced</th>
<th>Meta Data</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Settings</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Expiry Date</td>
<td>--/--/---</td>
<td>Choose / Clear</td>
</tr>
<tr>
<td>Requires Approval</td>
<td>☐ Yes ☐ No</td>
<td></td>
</tr>
</tbody>
</table>

• In the Advanced Tab It is possible to set an expiry date for a user after which their login credentials are no longer valid; this applies to any User Type.

• Within Settings is the Requires Authorisation radio button option. The Yes setting will be automatically set if a user is being created via a User registration Custom Page. If the user is being created manually the No setting will be set on Save.

<table>
<thead>
<tr>
<th>General</th>
<th>Advanced</th>
<th>Meta Data</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Options</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>User</td>
<td></td>
</tr>
<tr>
<td>Edit on Save</td>
<td>☐</td>
<td></td>
</tr>
</tbody>
</table>

• In the Meta Data Tab you have the opportunity to select a User Content Type against the user if one has been created.

• Click onto the Save button to complete user details.

To change user details right mouse click onto the User name and select Properties.
Site User Authorisations

Site Users can be assigned authorisations for the following:

- **Secure Site Area**
  Areas marked as secure in the Area Manager require a user visiting the site to log in with appropriate credentials when visiting pages in that area. The Authorisations->Area option on the User/Group Menu allows you to set Read rights for pages in secure areas.

  The Site Area Authorisation Form will show all the Site Areas, checkboxes will be available wherever it is possible to set Authorisations for that user or group. Site Users will be able to set Read Authorisations on Secure Areas only. Ticking a checkbox will enable access for that particular Area when the form is saved:

- **Secure Newsgroups**
  If Newsgroups are created as being secure users need to be authorised before they can contribute, this can be done through the Authorisations->Newsgroup option. Read options should be granted for the newsgroup that the Site User is to access, assigning moderate authorisations to a Site User will have no effect.

- **File Library**
  If file searching is enabled Site Users can be authorised to search the contents of files in a particular library in the site search. Setting update authorisations for a Site User will have no effect.
Content Contributor Authorisations

When Content Contributors are created unlike Administrators they do not have full access to all available areas, instead they will have access to just the top level area and any areas that they create. Access to other areas if required is controlled by the Site Authorisation form by clicking onto user name, hovering mouse over Authorisations and selecting Area. The authorisations available are described as follows:

- **Area**
  Area Authorisations can be set for Content Contributors in a similar way to Site Users, with the difference that they can also be authorised to Delete, Update and Publish Areas and pages within those areas. Content contributors will only see the Areas they area authorised to edit in the Content Manager.

- **Newsgroups**
  Content Contributors may also be authorised to moderate Newsgroups, they will only be able to see Newsgroups they can moderate in the Newsgroup Manager as set by the Administrator.

- **File Library**
  Update and Search authorisations can be set. Content Contributors will only be able to upload new and replacement files to libraries they are authorised to update.

- **Multimedia Library**
  Update rights can be set on Libraries in a similar way to file libraries. Content Contributors will only be able to upload new and replacement multimedia items to libraries they are authorised to update.

- **Section Library**
  Update rights can be set on Section Libraries, allowing the Content Contributor to edit and create Sections.

- **Form Library**
  Update rights can be set on Form Libraries, allowing the creation and editing of forms in the authorised library.

- **Menu Library**
  Update rights can be set on Menu Libraries, allowing the creation and editing of menus in the authorised library.

**Note:** In each of the Libraries the Default Library is accessible to all Content Contributors; update authorisations for the Default Libraries cannot be set.
Restricting User Options

User options allow role customisation for specific Content Contributors and Administrators. This Feature allows an Administrator to choose the Activedition managers that are available to a either a Content Contributor or another Administrator when they log in to Activedition. The User Options Screen allows you to use Checkboxes to determine the managers available for that particular user:

Users Requiring Approval

If a user has been created by completing an on-line user registration form or the Requires Approval option was set to Yes when creating user then an Administrator has still to approve access to the site for that user.

Process

- In the User Manager click onto the User Type drop down list and select Users Requiring Approval.
- Right mouse click on user name, hover mouse over Tasks and select the option Approve User.
- Click onto the Confirm button to approve the user.

Advanced Meta Data Filter

The Advanced Meta Data Filter allows you to write out a data query string to search for users that have had an attribute set against their user name on creation. For example the attribute UserTown may have been created in the User Content Type and applied to users in the User Manager on creation. Using the Advanced Meta Data Filter we can now search for users who live in a specified town providing that attribute has been updated.

The syntax for the data query string is [AttributeName operator ‘value’], for example the [UserTown EQUALS ‘Dundee’] data query string will return all users living in Dundee.
Operators that can be used with the Advanced Meta Data Filter are as follows:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>EQUALS</td>
<td>Equals to</td>
</tr>
<tr>
<td>NOT EQUALS</td>
<td>Not equal to</td>
</tr>
<tr>
<td>GTOET</td>
<td>Greater than or equals to</td>
</tr>
<tr>
<td>LTOET</td>
<td>Lesser than or equals to</td>
</tr>
<tr>
<td>GT</td>
<td>Greater than</td>
</tr>
<tr>
<td>LT</td>
<td>Lesser than</td>
</tr>
</tbody>
</table>

**Note:** These operators can be used in upper or lower case.

Several data queries can be nested by using the operands OR and AND, the syntax for a nested query is `[AttributeName operator ‘value’] operand [AttributeName operator ‘value’]`, for example the data query string `[UserTown EQUALS ‘Dundee’] OR [UserTown EQUALS ‘Perth’]` will return all users living in Dundee or Perth.

Both operands can be used in the one query string providing the OR statement is encased in brackets. The reason for this is that the AND operand has a higher precedence then OR, for example the statement ‘a AND b OR c’ will only return a and b completely ignoring c, whereas the statement ‘a AND (b OR c)’ will either return a and b or a and c.

**Creating Groups**

The process for either creating Primary or Secondary groups is the same as follows:

- Right mouse click onto *User Manager* at the top of the tree view, hover mouse over *Add* and select either *Primary* or *Secondary Group*.

  ![Group Creation Form](image)

- Enter a name in the ID field. The ID field is the main group name that will appear in the user and group list. This cannot be edited once the group has been created.
• Enter a name in the **Friendly Name** field. This is a descriptive name for the group that will appear in brackets after the **GroupID** in the user and group list. Systems with complex user structures may have complex GroupID names (e.g. su_grp146a,) this field offers a more understandable name.

• In the **Authorisation Level** section select one of the three available options.

To change user details right mouse click onto the **Group** name and select **Properties**.

Once created user and group members / memberships can be managed through the **Select Group Members**, or **Select Group Memberships** Menu Options.

**Sending Messages**

It is possible to send either emails, or Activedition stored Messages to either users or user groups.

**Process**

• Right mouse click onto require user or group, hover mouse over **Send** and either select **Email** or **Stored Message**.

• Either create message or select stored message and send.

**Notes**
Exercise: User Management

Creating groups and users with access to secure site areas

- Create a new Site User primary group *myname_members* and set authorisations:
  - Read Access on the *myname_members* area (this should be a secure area)
- Create a user and add it to the *myname_members* group
- View the inherited permissions on the user. Place a link to the *myname_members* page from the *myname_home* page, and publish the page.
- Log out of Activedition and close all browser windows. Visit the Live Site and navigate to the *myname_home* page, follow the link to the *myname_members* page and log in.

Creating Content Contributor groups with different roles

- Create a new Content Contributor primary group *myname_ccs* and set authorisations:
  - Delete and update on *myname_home*
  - Delete and update on *myname_members*
  - Moderate and read on *myname_news* newsgroup
- Create a new Content Contributor secondary group *myname_pub* and set authorisations:
  - Delete, update and publish on *myname_home*
  - Delete, update and publish on *myname_members* + 3 other areas
  - Update on *all* libraries
- Add the *myname_pub* group to the *myname_ccs* group
- Create 2 users, add one to *myname_pub*, one to *myname_ccs*
- Edit the user authorisations for the user in the *myname_ccs* group, remove access to the multimedia library manager (Tasks->User Options)
- Log in to Activedition as the two users noting the difference
- Try and publish a page when logged in as the user that is a member of *myname_ccs*
- Use the area manager to set authorisations
Lesson Seven - Notification Lists

Notification Lists allow any user or group of users to be notified when the whole site, one or more areas, or one or more specific pages (in a single area) status changes to any one of the statuses present in the workflow (i.e. Draft, Awaiting Publishing, Published).

Common uses for this are to inform publishers with editorial control to be informed when a page is ready for their approval and publishing, or when managers or other staff need to be informed when content on the live site has been updated.

Notification Lists require Workflow to be turned on; unless Workflow is enabled in the System Options the Notification List Manager will not be visible in the Manager List in the Main explorer.

Creating Notification Lists
Notification List creation is a 4 step process:
1. Edit Properties
2. Select Message
3. Associate List
4. Add list Members

Step One - Edit Properties
First choose the Add Notification List option from the menu and you will be prompted to set up the basic properties:

- **Name**
  This is the Name of the list as will be displayed in Activedition.
• **Type**
  This determines the nature of the Notification, Email, entry in the Activedition task list or both.

  Options are:  Email, Add entry to task list, and Email & Task.

• **Attach Page**
  If the selected type includes an email notification the page can be attached to the email sent.

• **Notify group when status becomes**
  These options determine when Notification Lists are sent out. When a page within the Associated List content changes status and the status is included in the rules, a notification is sent out.

  Options are:  Draft, Awaiting Publishing, and Published.

Once the Notification list has been added you will be able to edit these fields by choosing the Properties option on the menu for that Notification List.

---

### Step Two - Select Message

Save this form and you will be prompted to choose the message that is sent out with this notification, this could be something like ‘Please Review and Publish’ If no suitable message is available you can add one that is appropriate to your needs.

---

### Select Message

![Select Message](image)

**Message**

Please Select A Message

Add Message

---

**Step Two - Select Message**

Save this form and you will be prompted to choose the message that is sent out with this notification, this could be something like ‘Please Review and Publish’ If no suitable message is available you can add one that is appropriate to your needs.
Once the Notification List has been created the message can be edited by choosing the Tasks->Edit Message menu option for that Notification List.

**Step Three - Associate List**
When the message has been saved you are prompted to choose what parts of the site trigger a notification when pages change status as specified in the first step.

1. Choose whether the list is to be associated with the site, areas or pages.
2. If associated with Areas choose one or more areas from the list, if associated with pages choose an area and then one or more pages from the list.
3. Save.

Once the Notification List has been created the message can be edited by choosing the Tasks->Associate List menu option for that Notification List.

**Step Four - Add List Members**
This allows you to add members to the notification list; this is done in a similar manner to added users to a group. Each of the users, and users in a group added will be notified when an appropriate page moves to the specified status (es.)
Once all the appropriate members have been added click the Close button to complete the Notification List creation process. The new Notification List will now be added to the list on the left.

Notes
Exercise: Notification Lists

- Create a new Notification List myname_Npub
  - Awaiting Publishing / Task list only
  - Add an appropriate message
  - Associate with myname_home and myname_members Area
  - Add the user that is a member of myname_pub

- Create a new Notification List myname_Ndraft
  - Draft / Task list only
  - Add an appropriate message
  - Associate with myname_home and myname_members Area
  - Add the user that is a member of myname_ccs

- Log in as a member of myname_ccs
  - Edit 2 pages
  - Submit them for publishing with Comments

- Log in as a member of myname_pub
  - Note the task in the task manager
  - Use the link to the workflow status report to reject one page with comments
  - Publish the other page

- Log in as a member of myname_ccs
  - Note the task in the task manager

Notes
Lesson Eight - Mailing Lists

This manager allows you to create Mailing Lists based on the Users and Groups in the User Manager. In the same way that Users can be organised into Primary and Secondary groups, Primary and Secondary Mailing Lists can be created.

HTML or text emails, and Activedition stored messages can be sent to all subscribed members of a mailing list. Mailing Lists differ from User Groups in that while members can be added and removed through the manager, individual users can subscribe or unsubscribe from mailing lists by visiting the mail Subscription page (in the Site Tools Area.)

Authorisations on Mailing Lists allow private newsletters, such as a Staff newsletter to be created by only allowing members of the Staff User group to subscribe to the mailing list. Users that aren’t a member of the Staff group would not see the options for the Staff Newsletter on the mail subscription page.

Creating Mailing Lists

When creating a mailing list you need to specify a List ID and Friendly Name, similar to the user manager. Note that Mailing List IDs and User Group IDs have to be unique; you cannot have both a User Group and Mailing List of the same name.

Process

- Right mouse click onto the Mailing List Manager name at the top of the tree view, hover mouse over Add and select required Email List.

- In the General Tab enter a name in the ID field. The ID field is the main group name that will appear in the email list. This cannot be edited once the group has been created.

- Enter a name in the Friendly Name field. This is a descriptive name for the group that will appear in brackets after the GroupID in the Mailing List Manager.

- Additional to the above it is possible to specify whether authorisation is required to subscribe to the list. If this option is chosen it is important to set authorisations for the mailing list to allow users to subscribe to it.
In the Filter Tab the Meta Data Filter allows you to write out a data query string to search for users that have had an attribute set against their user name on creation. For example the attribute Region may have been created in the User Content Type and applied to users in the User Manager on creation. Using the Advanced Meta Data Filter we can now search for users who live in a specified Region providing that attribute has been updated.

The syntax for the data query string is `[AttributeName operator 'value']`, for example the `[Region EQUALS 'Dundee']` data query string will return all users living in Dundee.

Operators that can be used with the Advanced Meta Data Filter are as follows:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>EQUALS</td>
<td>Equals to</td>
</tr>
<tr>
<td>NOT EQUALS</td>
<td>Not equal to</td>
</tr>
<tr>
<td>GTOET</td>
<td>Greater than or equals to</td>
</tr>
<tr>
<td>LTOET</td>
<td>Lesser than or equals to</td>
</tr>
<tr>
<td>GT</td>
<td>Greater than</td>
</tr>
<tr>
<td>LT</td>
<td>Lesser than</td>
</tr>
</tbody>
</table>

Note: These operators can be used in upper or lower case.

Several data queries can be nested by using the operands OR and AND, the syntax for a nested query is `[AttributeName operator 'value'] operand [AttributeName operator 'value']`, for example the data query string `[Region EQUALS 'Dundee'] OR [Region EQUALS 'Perth']` will return all users living in Dundee or Perth.

Both operands can be used in the one query string providing the OR statement is encased in brackets. The reason for this is that the AND operand has a higher precedence then OR, for example the statement ‘a AND b OR c’ will only return a and b completely ignoring c, whereas the statement ‘a AND (b OR c)’ will either return a and b or a and c.

An example on how Meta Data Filter can be used within the Email Manager is as follows:

An organisation requires a different email list for each sales region.

One strategy of dealing with this would be to create a Primary Mailing List for each region and then add current users to the List. The problem here is who lives in what region and what happens if they move out of that region to another. A solution would be to create a Meta data attribute in the User Content Type called...
Region so that when a User is created a region is attributed to that user. Next create a Secondary Mailing List called ‘Master’ and place all users in this Mailing List. In the created ‘Region’ Primary List create a Meta-Data Filter that points to the required Region e.g. [Region EQUALS ‘Dundee’] then Add the Secondary Email List ‘Master’ to it. Only those users from the Master List who live in the Dundee region will be added to this region list.

Basically you only ever need to create one Master List and using Meta Data and the Meta Data Filter many smaller email lists can be created.

Once the mailing list is created, users can be authorised and members added to the mailing list through the Select Email Subscribers and Tasks->Authorisations options. The user interface for each is similar to that for managing user group memberships.

Selecting Email Subscribers

Once a Mailing List group is created users can either subscribe to the list using the mailSubscription custom page which is found in the Site Tools Area or Administrators can manually add users to the list.

Process

- Right mouse click onto required Mailing List and click onto Select Email Subscribers.

<table>
<thead>
<tr>
<th>The Current Subscribers of Secondary Email List are shown below.</th>
</tr>
</thead>
<tbody>
<tr>
<td>ali (ali ali)</td>
</tr>
<tr>
<td>allan (Alan Miller)</td>
</tr>
</tbody>
</table>

- In the Subscribers form click onto the Add button and either select a group or user name for addition to the list.
Sending Messages

Once lists have been created it is possible to send either emails, or Activedition stored Messages to all the members of a particular Mailing List.

Process

- Right mouse click onto require user or group, hover mouse over Send and either select Email or Stored Message.
- Either create message or select stored message and send.

Select Close when completed.
Lesson Nine - Email Messages

This manager gives you the ability to create Text or HTML messages that can be sent to Users, Groups or Mailing Lists. Messages can be personalised by embedding user detail fields; Forename, Surname, UserID, and Password in the body of the message.

Creating a Stored Email message

- In the Email Message Manager right mouse click onto the Email Message Manager name at the top of the treeview and select Add Message.

<table>
<thead>
<tr>
<th>General</th>
<th>Advanced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name *</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>Subject *</td>
<td></td>
</tr>
<tr>
<td><strong>Body Text</strong> *</td>
<td></td>
</tr>
</tbody>
</table>

- In the General Tab add a name for the message in the Name field. The name as displayed when choosing a message to send from the User or Mailing List Manager.

- In the Description field add a brief description of the content / purpose of the message, this is shown along with the message name and body prior to sending to a
User, Group or Mailing List.

- In the Subject field enter the subject of the email to be sent, as per a standard email message.
- Enter the content of the message in the Body Text section, either as plain text or HTML source code accordingly.

![General and Advanced Settings](settings.png)

- In the Advanced Tab select the importance level of the message to be sent, as per a standard email message.

- In the Format dropdown list either HTML or text format can be selected, Personalisation tags can be embedded in either HTML or text messages.

- Attachments can be added in the Attachment field. To add an attachment, first browse to the file to be attached then click the Upload button. All uploaded attachments will be listed at the bottom of the form.

- When the message is completed click onto the Save button in the General Tab.

Personalisation tags

The following tags are available to use within the message body:

- Forname `<Forename />`
- Surname `<Surname />`
- Username `<Username />`
- Password `<Password />`

To use simply type the required tag into the body of the email message.

**Note:** These tags will only provide the relevant information if the details are held in the User Manager.

---

**Notes**
Exercise: Mailing Lists and Email Messages

- Create a Primary mailing list myname_mMem
  - Requires Authorisation
  - Subscribe the myname_members group to this list

- Ensure that a link to the mailSubscription page in the SiteTools area is placed on a page in the myname_members area. Ensure the appropriate pages are published, log out of Activedition and close all browsers. Open the Live Site and Log in to the member’s area and edit the mailing list subscriptions.

- Add a stored message for a newly registered user including tags for the username and password, send this message to a user.

- Email a Published page to the myname_mMem List.

Section Four - Review

Lesson Summary

In this Section you learnt:

1. How to add new users and user groups to the system
2. The difference between Primary and Secondary groups
3. About User and Group properties
4. About the following Site user authorisations:
   a. Secure Site Area
   b. Secure Newsgroups
   c. File Library
5. Creating groups with different roles
6. How to create Notification Lists and what they do
7. How to create and use Mailing Lists
8. How to create Email messages and send them either to users, user groups or mailing lists

Notes
Section Five - System Configuration

Aims and Learning Objectives

This section gives an overview of the Activedition configuration options that are available to Administrators. Here you will learn how to use and update the Language Manager, use the Code Manager, how to reactivate the system and use the configurable system options. After this section you will have learnt the following:

• What the Languages Manager does and how it can be updated.
• How to use the Code Manager and its functionality.
• How to reactivate the system and determine the modules enabled and time left before the key expires.
• How to view what System Modules are accessible.
• How to configure the system options including enabling Workflow and Text only publishing, setting system defaults and enforcing accessibility standards.
Lesson Ten - Languages and Code Manager

The Language Manager

The Language Manager is used to control the Meta tags that write out the appropriate character set encoding information used in the HTML source of a page that has a particular language applied to it (through the page or site area properties.)

Adding a new language

- In the Language manager right mouse click onto the Language Manager name at the top of the tree view and select the Add Language option.

  ![Add New Language](image)

- In the Name field enter the name of the new language and save, once saved the language will appear in the list.

- To add the appropriate Meta tags right mouse click the language in the list and choose the Explore Language option.

- Right mouse click the language name and choose the Add Meta Tag option and add the Meta tag detail in the textbox provided.

  ![Add Meta Tag](image)

- Click onto Save when completed.
The Code Manager

This is a simple configurable database used by Activedition to store information used in the management application and usable by custom pages and extensions to Activedition to store configurable options that can be updated by business users.

The Manager is organised into Code Categories, visible by clicking the Choose button:

Clicking a category will show all the code entries for that category, for example the FONTFAMILY category stores all the fonts that are available through the Code Manager.

It is important that the existing categories and entries are only edited by advanced technical users.

One example of how the code manager could be used within an application would be to store the Bank of England base rate for a mortgage calculator application.

Notes
Lesson Eleven - System Features

Update Activation code

Used to reactivate the system when the activation key has expired or the licence has been upgraded. In this case a new key will be supplied by the reseller.

Modules Enabled

This displays the enabled and disabled modules in Activedition, disabled options becoming available when the licence is upgraded. Individual modules, such as meta-data and LDAP, may also be purchased individually. The number of administrators allowed, any restrictions on the number of Site Areas and Pages (an entry of 0 means unrestricted) and days until the key expiry is also listed.
Lesson Twelve - System Options

The System Options interface allows system and site settings to be amended or changed and consists of the following six Tabs:

| Project Settings | Delivery Application | Module Settings | Statistics | General | Accessibility |

**Project Settings**

**Project Properties**
- **Project Number**
  Usually 1, this is used internally by Activedition.

- **Name**
  This is the name of the project as seen on the live site link in the toolbar, changing the project name may result in the site becoming unavailable dependant on the way that the server is configured. It is strongly recommended that this is not changed.

- **Base URL**
  The Base URL is the URL that is used for the initial site installation, this setting should only be changed if for example the domain name changes. For more information contact your support agent.

- **Include Project Name in URL**
  This setting should not be changed before speaking to your support agent.

**Project Defaults**

- **Area Style**
  Sets the stylesheet that will be selected by default in an areas properties when it is being created.

- **Page Title**
  The text entered here will be used as the default title in the page properties when it is being created, this is not fixed and can be deleted / edited as appropriate for a particular page being created. It is recommended that this is used as a prefix only, considering that the title of a page when created is used as the default text for any link to that page.

- **Page Heading & What’s New Headline**
  Similar to the Default Page Title, the text entered here will be used as the default in the page properties when being created.

- **Headline Expiry Days**
  This is the default length of time that a headline will appear on the What’s New page and can be over-ridden when a page is being created. If the Default Expiry is set to 7 days, this amount of time will be added to the current date for the Headline Expiry when a page is being created.

- **Site Template**
  Sets the template that will be selected by default in an areas properties when it is
being created.

- **Fixed Template**  
  Allows a fixed template to be set site wide.

- **Page Workflow**  
  If Workflow is enabled this option allows a predefined workflow to be used as default site wide.

- **Office Upload Multimedia Library**  
  This is the default library for multimedia uploads when using the Office Upload to create pages

| Project Settings | Delivery Application | Module Settings | Statistics | General | Accessibility |

**Delivery Application**

**Custom Page Settings**

- **Allow File Searching**  
  If enabled uploaded files are also included in the site search. Enabling this option also makes the *include* in search option available in the file library properties.

- **Enable Best Bet Search Results**  
  Best Bets Searching will return bulleted results at the top of the search results based on the relevance of title, keywords and content.

- **Spell Check Search Pages**  
  If enabled allows spell check on Search Pages.

- **Search XML Configuration**  
  Configuration file for search results.

**Content Delivery Options**

- **Direct File Links**  
  If enabled any file links will try and open in the browser rather than using the usual Open / Save dialogue. This option may be overridden by local settings.

- **Enable Text Only Publishing**  
  Determines whether a text only version of the site is also published, to add text only to a site that does not have it involves creating text only templates and updating the current templates to include a text only switch, enabling this option and then publishing the entire site. Full details are available from an Activedition reseller.

- **Allow Links in Newsgroups**  
  Allows ability to link to items in Link Library.

- **Tiered Menu Type**  
  Choosing a menu type from the dropdown list will determine how the menu is rendered in Activedition, default is list.
• **Schema Set to use**
  Activedition can publish content to either HTML or XHTML standards. Note that if the output schema is to be changed the tidy configuration file needs to be updated.

• **Server Username and password**
  The Server Username and password are added during the initial site setup and should not be changed.

---

**Module Settings**

**Spell Checking**
This specifies whether spell checking is enforced on the section editor or not.

**User Management**
An approval stored message can be selected from the drop down list along with an entered email address for the user approval.

**Version Control**
If the Version Control Module is enabled it is possible to control the number of versions stored from here. It is recommended that this is kept within sensible limits bearing in mind the manageability and database space used.

**Classification Lists**
Allows Government Categories to be uploaded if a new Government schema has been released. The GCL is an encoding scheme for the subject element of the current version of the e-Government Metadata Standard (e-GMS). The purpose of the subject encoding schemes is to make it easier for personnel to find information from all the electronic resources in the UK public sector.

**Miscellaneous**

• **Language**
  Sets the default language for pages created in the site; this is only available if the multi language module is enabled.

• **UTF-8**
  Delivers the Activedition management application in Unicode.
Statistics

Statistic Options

- **Page Statistics**
  Determines the default option for Page Statistics in page properties.

- **Enable External Link Logging**
  Determines whether click-throughs to external sites are stored and viewable in the site statistics.

- **Enable Search Term Logging**
  Determines whether search terms used in the Activedition site search are logged and viewable in statistics.

- **Backup Statistics to XML file Before Summarising**
  By default an XML file containing the statistics is created on the server whenever a set of statistics are summarised. It may be necessary to disable this to conserve server disk space if there is a very large volume of statistics being regularly summarised. Changing to or from the Disabled option requires that all external links are republished.

- **Record Spider/Bot Hits**
  Select this checkbox if you want to record Spider/Bot Hits.

- **Filter Spider/Bot Hits in Reports**
  Select this checkbox if you want to filter Spider/Bot Hits in Reports.

- **Geographical Statistics IP Address Update**
  Used for uploading and importing the IP2 location file.

General

Email Addresses

- **Support Email Address**
  Should errors occur in the live site - site visitors will be prompted to use this email address for any enquiries / support requests.

- **Form Email Address**
  All form postings will be sent to recipients (as specified in the Form Manager,) from this address.

- **Newsgroup From Email Address**
  All newsgroup postings emailed to moderators etc as specified in the newsgroup properties will be send from this address.

Activedition Configuration

- **SSL Management Application**
  This can be enabled if a security certificate is installed on the server so that the Activedition management application can be delivered over a secure connection if desired.
• **Error Reporting**  
If the redirect to error page is chosen, any errors encountered in the delivery application will be redirected to a generic error page containing an error code, this error code relates to an entry in the Activedition error log containing the full text of the error that would have been otherwise displayed.

• **Enable Workflow**  
Determines whether workflow (Draft -> Awaiting Publishing -> Published) is enabled. The Notification List Manager and Workflow Status report are enabled.

• **Page Check In / Check Out**  
Determines whether or not page locking is enabled.

• **Warn When Linking to Expired Content**  
A warning message will be displayed when linking to expired content.

• **Content Contributor File Publishing**  
Allows Content Contributors to publish files from the library.

• **Show Activedition News**  
Will display an Activedition news box in the Task Manager.

• **Image Settings**  
Sets the maximum height and width for an uploaded image, any uploaded image that is larger than the parameters set will be reduced to these settings.

**HTML Tidy**

• **Enable HTML Tidy**  
Enabling HTML Tidy offers an additional option in a sections properties allowing the Administrator or content contributor to tidy up the source code for the section based on the Tidy Configuration tool. This is required for XHTML output.

• **Edit Tidy Configuration File**  
If content is to be published to XHTML the tidy file will need to be reconfigured, full details can be provided by an Activedition reseller.

**Accessibility**

• **Enforce Accessibility Level**  
This option will enforce different fields, such as alternative text on multimedia items dependant on the accessibility standard chosen. It is important to note that checking any of these standards will not guarantee compliance with a particular standard as there are many facets to compliance outwith the control of the software. These would include template design, appropriate use of alternative text longdesc etc.

• **RNIB**  
This option will enforce elements from WAI 1 - 3 which relate to visual impairment.

• **Default Alternative Text**  
This will be used in the title of a link that opens in a new window.
**Exercise: System Configuration**

Familiarise yourself with the System options and change the following; you will have to coordinate with other candidates the order of performing these tasks.

- **Project Settings - Edit**
  - Default Area style
  - Default site template
  - Headline Expiry days

- View the changes when adding a new page

- **Module Settings**
  - Set the version control limit

- **General - Edit**
  - Support Email Address
  - Form Email address
  - Enable HTML tidy and apply it to a section of content
  - Disable workflow and publish a page

- **Accessibility**
  - Enforce RNIB
  - Set Default New Window text
Section Five - Review

Lesson Summary

In this Section you learnt:

1. About the functionality of the Language and Code Manager.

2. How to update the Activation code and determine the modules enabled.

3. How to configure the following System Options:
   a. Project Settings
   b. Delivery Application
   c. Module Settings
   d. Statistics
   e. General
   f. Accessibility

Notes
Section Six - Reports

Aims and Learning Objectives

This section details the Site Statistics and describes the functionality of available reports. Here you will learn about the various site statistics that Activedition logs, export and summarise these statistics and be aware of other reports and utilities available in Activedition. After this section you will have learnt the following.

- Candidates will be aware of the various site statistics that Activedition logs and how to view them.
- Candidates will be able to Export and Summarise Statistics.
- Candidates will have an understanding of the other reports and utilities available in Activedition.
Lesson Thirteen - Statistics

Most of the statistics available in Activedition generate reports that are filtered by the following criteria:

- **Time Period**
  Either Today, All Time or a specified number of Days, Months or Years

- **User Type**
  All Users and Non Users, Users Only or Non-Users where Users are visitors to the site that have logged into a secure area and Non-Users are everyone else.

The reports that are available are compiled from all the non summarised statistics in the database, when a particular month of statistics are summarised they are no longer included in the detailed statistics. For this reason it is recommended that, if you want to keep a record of the detailed statistics they are exported prior to being summarised. Statistics should be summarised on a monthly basis.

**Page Statistics**

Page hit statistics based on the top 10 pages and last 100 hits, Page hit detail in the results will break down the hits per day for a particular page.

**Area Statistics**

Displays the number of hits in the 10 most popular areas.

**Visitors Statistics**

This Report shows the number of visitors to the site, detailing the date and the number of pages viewed, or the visitor details and paths through the site.

**Visitor Geography**

This report displays the geographical location of each visitor to the site based on users IP address.

*Note:* This is an optional module and may not be displayed.

**Search Term Statistics**

Logs the search terms used in the Activedition site search if enabled in System Options, this can be useful for updating page keywords.

**External Link Statistics**

Lists either the top 10 or last 100 click throughs to external sites if enable in System Options. The number of click throughs and a link to view the external site is available for each entry.

**Live Statistics**

Gives details of who is currently visiting the live site, with the option to do an IP address lookup and see the pages viewed.
Summary Statistics

These give highly useful statistics drawn from the detailed stats viewed in the previous reports. To summarise the statistics for a particular month choose it in the Months. To Summarise droplist and click the Perform Summary button. The system will automatically perform the summary, be patient as this can take some time dependant on the volume of statistics for that month:

Once Complete the summarised statistics will be available to view in the View Summarised Statistics, Month droplist, selecting the month and clicking the Show Statistics button will display the statistics:

- **Site Activity Analysis**
  View the total number of visits to your site, how many pages hits your site received and the total time spent on your site by visitors.

- **Page Usage Analysis**
  View the most popular, least popular, common entry and common exit pages for your site.

- **User Agent Analysis**
  View breakdowns of the browser types which are being used to view your site as well as the operating systems that your users have installed.

- **Visitor Geographic Analysis**
  View the most common geographical locations of visitors to the website.
  **Note:** This is an optional module and may not be displayed.

- **Referrer Activity Analysis**
  See the most common websites which referrer users to your site.

- **External Link Analysis**
  View the External Link Click-Throughs in rank order for your site.

- **Search Term Analysis**
  View the Search Terms used on your site in rank order.
Export Statistics

Statistics can be exported to CSV format for reference and analysis before they have been summarised. Exporting statistics leaves them available for all other statistics reports.

To export the statistics choose the time window that you want to export the statistics for by setting the start and end dates then click the export now button. Once complete you will be shown details of the stats export and a link will be available to download the exported statistics:

Export Information:

Date From: Tuesday, February 21, 2006
Date To: Monday, July 03, 2006
Number of Rows To Export: 202

Current Exported File:
Date Created: Saturday, June 17, 2006
11:17:14 AM
File Size: 785.13 (KB)

Download File

Notes
Lesson Fourteen - Other Reports

Page Status Report

Helps keep track of sitemap, what’s new, expired, island pages and combinations of these. This is especially useful if date validity is used a lot in a site, or during site maintenance to get an idea of how many island pages are on the site.

Authorisation Report

Gives a quick overview of who is authorised to do what on the site. Will display authorisations for particular site areas, newsgroups and file libraries.

Logged Activity

Tracks activity in the management interface, detailing the creation, editing and deletion of different items in the system. If trying to track down a particular incident (form update, page delete) the user and date range can be specified.

Notes
Content Review Report

This utility can be used to help keep content fresh on key pages within the site. If pages are marked for review in their properties they will appear in the report. The report highlights pages due for review now and shortly, and also those past their review date, with colour denoting different statuses.

Check In/Out Report

This report allows Administrators to view the Check In/Out status of pages within the website. As well as being able to specify status and areas in the filter section Administrators are also able to check in or out pages using this report.

![Check In/Out Report](image)

Notes
Workflow Status Report

As well as being used by the notification lists this report can be used in its own right to manage publishing. Choosing the Status will display all pages in the site with that status, and appropriate management options, if desired a further filter can be applied to choose pages in only a particular area.

### Notes
Section Six - Review

Lesson Summary

In this Section you learnt:

1. About the following site statistics and how to view them:
   a. Page
   b. Area
   c. Visitors
   d. Search Term
   e. External Link
   f. Live

2. How to summarise and export statistics

3. About the other following reports:
   a. Page Status
   b. Authorisation
   c. Logged Activity
   d. Content Review
   e. Workflow Status

Notes
Appendix A - Glossary

A

Active Directory  Microsoft’s directory database for Windows 2000 networks. Stores information about resources on the network and provides a means of centrally organising, managing, and controlling access to the resources. See LDAP

ActiveX  A set of technologies that allows software components to interact with one another in a net-worked environment, regardless of the language in which the components were created.

ActiveX control  A reusable software component that can be used to incorporate ActiveX technology.

ASP  An Active Server Page (ASP) is an HTML page that includes one or more scripts (small embedded programs) that are processed on a Microsoft Web server before the page is sent to the user.

B

Browser  A Web access program that can request HTML documents from Web servers and render such documents on a user’s display device.

Bookmark  A reference to a site held within the Browser in a list of URLs.

C

CSV  Comma Separated Value. CSV is a file format used as a portable representation of a database. Each line is one entry or record; the fields in the record are separated by commas. This format is often used to import data into spreadsheet software.

D

Document  The basic unit of HTML information, a document refers to the entire contents of any single HTML file. Because this concept doesn’t always correspond to normal notions of a document, we refer to what could formally be called HTML documents more or less interchangeably with Web pages, which is how such documents are rendered by browsers for display.

Double-Click  To rapidly press and release a mouse button twice without moving the mouse. Double-clicking carries out an action, such as starting a program.

Download  To transfer a file from a server to a user across a network or the internet.

Drag  To move an item on the screen by selecting the item and then pressing and holding down the mouse button while moving the mouse.

E

e-mail  An abbreviation for electronic mail, e-mail is the preferred method for exchanging information between users on the internet (and other networked systems).

External reference  A resource that is stored somewhere other than where a Web document or program is located.
F

FAQ  Frequently Asked Questions. A FAQ is a list of questions and answers about a specific subject.

File  A collection of information that has been given a name and is stored on a disk. This information can be a document or a program.

Forms  In HTML, forms are built on special markup that enables browsers to solicit data from users and then deliver that data to specially designated input-handling programs on a Web server. Briefly, forms provide a mechanism to enable users to interact with servers on the Web.

G

GIF  (Graphics Information File)  GIF is one of a set of commonly used graphics formats within Web documents. GIF is commonly used because of its compressed format and compact nature.

Graphical User Interface  See GUI.

Graphics  In HTML documents, graphics are files that belong to one of a restricted family of types (usually GIF or JPEG) that are referenced via URLs for inline display on Web pages.

GUI  (Graphical User Interface, pronounced gooey)  GUIs are what make graphical Web browsers possible; they create visually oriented Interface that makes user’s interaction with computerised information easier.

H

HTML  (Hyper Text Markup Language)  The language used to create Web pages. Not quite a programming language, HTML, nevertheless provides a rich lexicon and syntax for designing and creating useful hypertext documents for the Web.

http  or HTTP  (Hypertext Transfer Protocol)  The Internet protocol used to manage communication between Web clients (browsers) and servers.

Hyperlink  A shorthand term for hypertext link. See also hypertext link.

Hypertext  A method of organising text, graphics, and other data for computer use that lets individual data elements point to one another, hypertext is a nonlinear method of organising information (especially text).

Hypertext link  In HTML, a hypertext link is defined by special markup that creates a user selectable document element that, when selected, can change the user’s focus from one document (or part of a document) to another.

I

Internal link  A hyperlink on a Web site that links to a resource on the same site (or in some cases, within the same document).

Internet  A global network of networks.

Intranet  A Transmission Control Protocol/Internet Protocol (TCP/IP) network that uses Internet technology. May be connected to the Internet.
**JavaScript** A programming or script language, which can be imbedded in Web pages and read by the browser. It can be used to do things such as open a separate browser window or to display a message when the mouse moves over an object on the page.

**JPEG or JPG** (Joint Photographic Experts’ Group) An Industry association that defined a particularly compressible format for image storage that is designed for dealing with complex colour still images (like photographs). Files stored in this format usually take the extension JPEG (except on DOS or Windows machines, which use the three-character JPG equivalent). Today, JPEG is emerging as the graphics format standard of choice for use on the WWW.

**LDAP** See Lightweight Directory Access Protocol

**Lightweight Directory Access Protocol (LDAP)** The primary access protocol for Active Directory.

**Link** For HTML, a link is a pointer in one part of a document that can transport users to another part of the same document or to another document entirely. This capability puts the hypertext into hypertext.

**Libraries** These are repositories that hold resources such as multimedia or forms.

**Meta** A prefix to indicate something applied to itself; for example, a metameeting is a meeting about meetings

**Metadata** Information about the properties of data, such as the type of data in a column (numeric, text and so on) or the length of a column. Information about structure of data.

**Metatags** This is a special HTML tag that is used to store information about a Web page but is not displayed in a Web browser. For example, meta tags provide information such as what application was used to create the page, a description of the page, and keywords that are relevant to the page. Many search engines use the information stored in Meta tags when they index Web pages.

**Multimedia** A method of combining elements such as text, sound, graphics and full-motion or animated video within a single compound computer document.

**Newsgroup** An electronic discussion group or bulletin board that is devoted to discussion of a specific topic. A newsgroup consists of postings, which are messages that have been addressed to the newsgroup rather than a specific individual.

**Pages** The generic term for the HTML documents that Web users view on their browsers.
**PDF** (Portable Document Format)  The name of the document format for Acrobat from Adobe Systems, Inc. PDF is also used as the file extension for files in this particular format.

**Publish**  Publishing Pages or Areas will make them available to the live site.

**Server**  In general, a computer that provides shared resources to network users.

**Section**  An area that contains textual content or items placed from the various resource libraries such as the Multimedia, Link and Tag libraries. Where Sections appear on a page is determined by the template.

**Section Library**  Allows sections to be managed on a per library basis, any changes made to a section held in the section library will affect all placements of that section throughout the site.

**SGML**  Standard Generalized Markup Language. SGML is an information management standard adopted by the International Organization for Standardization (ISO) in 1986 as a means of providing platform- and application-independent documents that retains formatting, indexing, and linked information.

**Site**  This is a container for Site Areas, when logged into activedition you can only manage one Site.

**Site Areas**  These can contain other Site Areas, allowing hierarchical structures to be built similar to Directories on a PC. Site Areas can also contain Pages.

**SSL** (Secure Sockets Library)  A Web commerce programming library, intended to help programmers to easily add secure transactions across the Web.

**Style Sheet**  The Style sheet defines the fonts, sizes and colours used, substantially enforcing brand consistency across the site.

**Tag**  A small snippet of HTML Code.

**Template**  Activedition templates are constructed in standard HTML like any other webpage. With specialist activedition tags embedded in the code to control the location of content and other items on the pages.

**URL** (Uniform Resource Locator)  The primary naming scheme used to identify Web resources, URLs define the protocols to be used, the domain name of the Web server where a resource resides, the port address to be used for communication and the directory path to access a named Web file or resource.

**UTF 8**  UTF-8 (8-bit Unicode Transformation Format) is a lossless, variable-length character encoding for Unicode. It uses groups of bytes to represent the Unicode standard for the alphabets of many of the world's languages. UTF-8 is especially useful for transmission over 8-bit mail systems.
**W**

**W3C** World Wide Web Consortium. An international industry consortium which develops common protocols that promote WWW evolution and ensure its interoperability.

**Web** Shorthand for the World Wide Web (or W3) it can also refer to a related, interlinked set of HTML documents.

**Web Server** A computer that is maintained by a system administrator or Internet Service Provider (ISP) and that responds to requests from a user’s browser.

**Web Site** An addressed location, usually on the Internet, that provides access to the set of Web Pages corresponding to the URL for a given site; thus a Web Site consists of a Web Server and a named collection of Web documents, both accessible through a single URL.

**Workflow** Used in conjunction with publishing. If Workflow is enabled the option of *Awaiting Publishing* is added as another status of publishing. In this case pages must be submitted for publishing prior to being published. This allows specific users to have editorial control over the content that is set live on the website.

**X**

**XML** Extensible Markup Language. XML is a subset of Standard Generalised Markup Language (SMGL) and is a standard for marking up data so as to clearly indicate its structure, generally in a way that indicates the meaning of different parts of it rather than how they will be displayed. See SMGL.